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Digital Signage at Penn State: The Basics 
 
OBJECTIVES 
Participants will be able to  

 create a simple digital sign. 
 locate and utilize Penn State templates for building a sign. 
 add media to a sign. 
 configure and schedule content for a sign. 
 deploy (run) a sign. 

 
WHAT IS DIGITAL SIGNAGE? 
 
Digital signage is a form of electronic display that shows current information, 
advertising and other messages. Digital signs may stand alone or be networked. Digital 
signs can be non-interactive or interactive through the use of touch screens, barcode 
scanners, card swipes, RFIDs, and other input devices. 
 
This tutorial will guide you through the process of creating a digital sign. In this tutorial, 
all media for the sign will reside on the same computer on which the Content Manager 
is installed. This is an example of the sign you will create. 
 

 
 
REQUIRED FILES FOR THIS TRAINING 
 
For this training you are provided with an example image with which you will complete 
all exercises. Prior to the next exercise, your trainer will first place a Koala.jpg file on 
your desktop. 
 
Version of the Digital Signage Software Used for This Training 
 
Version 4.1.0 of the Four Winds Digital Signage Software is used for this training. 
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OBTAIN PENN STATE TEMPLATES 
 
Templates contain the background images and data regions for signs. Templates for 
each Penn State location with the Penn State logo, etc. are available for use. 
 
In this example, you will download the Penn State Templates from the Penn State Pass 
Explorer and place a copy on your desktop. 
 

1. Open the Firefox browser. 
 

NOTE: If you are working remotely, you must also use the VPN software to ensure 
a secure connection. Please see http://aset.its.psu.edu/vpn/ for more information 
and installation instructions. 

 
2. Type https://explorer.pass.psu.edu/ in the browser address bar.  

 

NOTE: You may need to authenticate with your Penn State user ID and Password 
to enter PASS Explorer. 

 
3. Choose <Enter a path> from the Browse To: drop-down menu. 

 

 
 

4. Type /pass/services/digitalsignage in the folder location dialog. 
 

 
 

http://aset.its.psu.edu/vpn/
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5. Click the OK button. 
 

6. Select the [samples] choice. 
 

 
 

7. Click the Change Folder button. 
 

 
 

8. Select penn-state-templates.zip. 
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9. Click the Download button. 
 

 
 

10. Click the Click to start download button. 
 

` 
 

11. Click the Save file radio button. 
 

12. Close the download dialog when the download completes. 
 

13. Navigate to the Downloads folder. 
 

14. Double-click the penn_state_templates.zip file to open it. 
 

NOTE: You may need to do step 14 twice as the template files may be double-
zipped. 

 
15. Copy the Four Winds folder onto your desktop. 

 
16. Close the Downloads folder. 

 
17. Close Firefox. 

 
18. Rename the Four Winds folder to PSU Four Winds Templates.   
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CREATE A FOLDER FOR STORING SIGN CONTENT 
 
Four Winds recommends storing all your sign content in one folder.  
 

1. Create a folder on the desktop and name it Digital Sign Content.  
 

2. Place the Koala.jpg image in this folder. 
 

3. Place all your future sign graphics, etc. in this folder. 
 
CREATE A NEW LOCAL DATABASE 
 
A database is where your digital sign templates and other internal data are stored. Your 
content (text, pictures, links, etc.) is not stored in the database. In Windows 7, a local 
database is stored on the same computer as the Content Manager software, within the 
C:\Users\Documents folder. Using a local database is most useful if a single person is 
maintaining a single sign. In this exercise, you will create a local database. 
 
Other database options include creating an SQL database and creating a local database 
with shared access. SQL databases are useful only if you will have multiple people 
editing the same sign at the same time. Establishing an SQL database will require local 
technical assistance and assistance from Four Winds. A local database with shared 
access is most useful if you will have multiple people editing the same sign and you can 
establish a schedule that ensures only one person will be editing a sign in a given period 
of time. Please see Appendix D for more information on establishing a local database 
with shared access. 
 
EXAMPLE 
In this exercise you will use the Content Manager Setup Wizard to create a sign for the 
second floor of the Business Building of the Smeal College of Business. 
 

1. Click on the Windows Start button. 
 

 
 

2. Click on All Programs. 
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3. Click on the Four Winds Interactive folder. 
 

 
 

4. Click on Content Manager. 
 

| 
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5. If you do not see the Content Manager Setup Wizard Dialog as shown, follow all 
sub steps a through d. If you do see the Content Manager Setup Wizard Dialog, 
proceed to step 6. 
 

 
 

a. Select New from the File menu. 
 

b. Click the Create a new local database radio button. 
 

c. Click OK at the Replace Existing Data dialog. 
 

d. Proceed to step 8. 
 

6. Click the Create a new local database radio button. 
 

7.  Click the Next button. 
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8. Type Penn State College of Business in the Name field (e.g.,) of the Set up your 

company dialog. 
 

 
 

NOTE: Many dialog boxes have optional fields. For this training, you will only 
complete necessary fields. 

 
9. Click the Next button. 

 
10. Type Business Building in the Name field of the Set up a signage location dialog. 

 

 
 

11. Click the Next button. 
 

  



 

Digital Signage at Penn State: The Basics  12 
   

12. Type Second Floor in the What should Content Manager call the signage player? 
field in the Set up Player dialog. 
 

 
 

13. Click the Finish button. 
 
You will now see your initial sign defined in the Network Overview.  Your  “company”  is  
the Penn State College of Business. Your location is the Business Building. You currently 
have one sign named Second Floor, indicating it is located on the second floor of the 
Business Building. 
 

 
 

  



 

Digital Signage at Penn State: The Basics  13 
   

EXPLORE THE CONTENT MANAGER INTERFACE 
 
The Content Manager is the software used to create your signs. The following image 
illustrates the Content Manager interface. 
 

 
 

Drop-down Menus 
 

 
 
 The File menu contains entries to create, open, save, and close a database. 
 The Network menu contains entries that control what's displayed in the view 

pane. 
 The Content menu contains entries to create, import, and export content items. 
 The Template menu contains entries to create, import, and export templates. 
 The User menu contains an entry to add a new user. 
 The Group menu contains an entry to add a new user group. 
 The View menu contains entries to control which panes are included in the 

Content Manager user interface, along with links to player status and history 
dialogs. 

 The Tools menu contains links to dialogs to manage advertising, Effective Local 
Time, content searching, and user settings. 

 The Help menu contains links to the About dialog and to online product 
information.  
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Network Overview 
 
This area shows you how your signs are set up and where your signs are located. 
 

 
 
In this example, Penn State College of Business is the company or organization, Business 
Building  is  the  building  “inside”  that  company,  and  Second  Floor  is  a  sign  “inside”  that  
building. 
 
Give careful thought to the way you name items at the company, building, and sign 
level. Attempt to model the real world as much as possible. 
 
Timeline Overview 
 
The Timeline enables a user to visualize the scheduling of content and templates. The 
view will display horizontal bars that line up with the templates, regions, and content 
items of the Network Overview. A purple bar indicates the scheduling for a template 
and a yellow bar indicates the scheduling for a region or individual content item.  
 
Solid bars indicate an item that is set to play all day, every day with no end date. Bars 
with breaks indicate special scheduling. 
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In this example, the Horizontal Readerboard is scheduled to play all day, every day. 
 

 
 
In this example, Breakfast/coffee promos is scheduled to play only in the morning of 
every day. 
 

 
 
Content, Templates, Users, and Groups 
 
This is a four-in-one area. You can click a tab at the bottom of this area to change 
between areas. 
 

 
 

 Content tab – Displays any media (text, pictures, etc.) you have added to the 
Content Manager. If you have a great deal of content, you can create folders here 
via the New Category command under the Content menu, then drag content 
into these folders for better organization. 

 Template tab – Displays any templates for signs to which you have access.  
 User tab – Displays any users you have added to the Content Manager. By 

default, anyone with access to the Content Manager can open it and access all the 
signs it contains. Adding one or more users to the Content Manager forces 
anyone using the Content Manager to log in with a user ID and password. 

 Groups tab – Displays any groups of users you have created and who is assigned 
to those groups. You can assign different levels of permissions to different 
groups (e.g., Group A can only access Sign A, and Group B can only access Sign 
B). 
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ADD THE APPROPRIATE PENN STATE TEMPLATE TO THE 
CONTENT MANAGER 
 
All signs have background images and data regions. Penn State has templates you can 
use to create a common look for your signs. 
 
EXAMPLE 
In this exercise, you will add the appropriate (to your campus college location) Penn 
State template to the Content Manager. 
 

1. Select Import Library from the Template menu. 
 

2. Locate the PSU Four Winds Templates folder on the desktop. 
 

3. Open the PSU Four Winds Templates folder. 
 

4. Open the folder specific to your college campus. For example, if you are from the 
Penn State York campus, open the York folder. 

 
5. Open the template1 folder. 

 
6. Select the template.ftl file. 

 
7. Click the Open button. 
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8. Click the OK button at the Select Templates dialog. 
 

 
 

9. Locate and select the Digital Sign Content folder previously created. 
 

 
 

10. Click the OK button. 
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ATTACH A PENN STATE TEMPLATE TO YOUR SIGN 
 
Once you have a template in the Content Manager, you need to copy it into a sign. 
 
EXAMPLE 
In this exercise, you will copy a template to your sign. 
 

1. Click the Template tab in the Content, Templates, Users, and Groups section of the 
Content Manager to see your added templates. 
 

2. Drag the template1 template up to the Second Floor sign in the Network Overview 
area of the screen to add that template to the sign. 
 

 
 

3. Click the Second Floor sign. 
 

4. Click the Preview button to preview the sign. 
 

 
 

5. Click the Preview button again to cancel the preview. 
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ADD MEDIA TO THE CONTENT MANAGER 
 
You can add a variety of media to your sign, including text, images, and data from other 
sources. First, you have to add non-text media to the Content Manager. 
 
EXAMPLE 
In this exercise, you will add a JPG image to the Content Manager. 
 

1. Select New from the Content menu. 
 

2. Select Image. 
 

 
 

3. Click the  icon to the right of the URL field to locate a file from your 
computer. 
 

 
 

NOTE: All dialog boxes look similar to this, whatever media type you choose. 
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4. Select Desktop from the options on the left.  
 

 
 

5. Open the Digital Content folder. 
 

6. Double-click the Koala JPG image. 
 

7. Uncheck the Duration checkbox in the Image Properties dialog. 
 

8. Click the OK button. 
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9. Select Save from the File drop-down menu to save your work. 
 

 
 

NOTE: You should periodically save your sign. 
 
PLACE MEDIA CONTENT IN A SIGN 
 
After you add media to the Content Manager, you can add it to your sign. 
 
EXAMPLE 
In  this  exercise,  you  will  add  the  text  “Koala”  and  a  Koala  JPG  image  to  a  sign. 
 

1. Select New from the Content drop-down menu. 
 

2. Select Text. 
 

 
 

3. Type Koala in the Name: field. 
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4. Type Koala in the Text: field. 
 

5. Uncheck the Duration checkbox. 
 

6. Click the OK button. 
 

 
 

7. Click the Content tab. 
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8. Drag the Koala text from the Content area to the left region header region within 
the sign. 
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9. Click the Content tab. 
 

10. Drag the Koala JPG image from the Content area to the left region content region 
within the sign.  
 

 
 

11. Click the Second Floor sign. 
 

NOTE: In  the  next  step,  the  word  “Koala”  will  appear  in  white  on  a  light  blue  
background. You may need to adjust the tilt on flat-screen monitors or the contrast 
on other monitors to see the word clearly. 
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12. Click the Preview button. 
 

 
 

13. Click the Preview button again to cancel the preview. 
 

NOTE: Content creation for a sign usually takes place before a sign is created. The 
exact type of content and tools you will use to create is dependent on your situation 
and too varied to cover in this training. 

 
SCALING MEDIA TO FIT A REGION 
 
Many times you will need to change the size of a media object (e.g., an image or video) 
to fit the region in which the media object will be placed. 
 
EXAMPLE 
In this exercise you will scale the Koala image so it better fits within the left content 
region. 
 

1. Right-click the Koala JPG image in the Content tab. 
 

2. Select Edit ‘Koala’…. 
 

 
 
3. Click the Advanced tab. 
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4. Select Center if smaller than container under the Scaling drop-down menu. 
 

 
 

5. Click the OK button. 
 

NOTE: Ideally you should prepare and size all images outside of the Content 
Manager, making sure the image sizes match as close as possible the size of the 
region to which they will be added. You can determine the size of a region by 
selecting the source template in which the region resides at the bottom of the 
Content Manager, right-clicking on it, and selecting Edit. The size (in pixels) of each 
region is then visible. Be sure to close the template without saving any changes. 

 
SCHEDULE CONTENT TO PLAY 
 
You may want to only show something for a limited period of time, rotate two or three 
things within the same region, etc. Setting the duration on a piece of media attached to a 
region allows you to do so. 
 
There are two places you can set the schedule for a piece of media – in the Content area 
or within the region to which the media is attached. Set the schedule in the Content area 
if you plan on always scheduling this media the same way, regardless of how many 
signs in which it is used. Set the schedule in the region area if the schedule for the media 
is particular to that sign. 
 
Set the Schedule for a Piece of Media in the Content Area 
 
EXAMPLE 
In this example, you will schedule the Koala image to play every day for one week. 
Every sign that uses this image will display this image for the same duration. 
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1. Right-Click the Koala JPG image under the left region content region and select 
the Existing Recurrences/All  Day… option. 
 

 
 

2. Click the End by radio button. 
 

3. Set the End by: field to one week after the current date. 
 
In this example, the current date was 11/14/2011. This media was scheduled to 
play every day (c) from 7/14/2011 (a) until 11/21/2011 (b). 

 

 
 

4. Click the OK button. 
 

NOTE: If this were a real sign, you would need to do this for the Koala text in the 
left header region as well. 

 
DEPLOY THE SIGN 
 
You must deploy a sign when it is ready for the public. Deploying a sign initially tells 
the Content Player to show the sign on the chosen screen(s), or when revisions to a sign 
are complete, the Content Player will update and display the latest version of the sign. 
 
EXAMPLE 
In this exercise you will deploy your Second Floor sign. 
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1. Right-click the Second Floor sign in the Network Overview area of the Content 
Manager. 
 

2. Select Deploy… from the menu. 
 

 
 

3. Click the Save Changes button if prompted to do so. 
 

NOTE: If you receive a Resolve message, click on the Resolve button. 
 

4. Click the Close button when the success screen appears. 
 

 
 
RUN THE CONTENT PLAYER 
 
The Content Player software presents the deployed sign to the public and must be 
installed on the computer used to display the sign. 
 
If changes to the sign are needed it will be necessary to edit the sign in the Content 
Manager, redeploy the sign, and run the Content Player again to view your changes. 
You may need to do this several times. 
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EXAMPLE 
In this exercise you will view your Second Floor sign in the Content Player software. 
 

1. Click on the Windows Start icon. 
 

 
 

2. Click on All Programs. 
 

 
 
3. Click on the Four Winds Interactive folder. 
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4. Click on Content Player to view the sign. 
 

 
 
It may take several seconds for the sign to appear. 
 

NOTE: The sign will not fit the current small screen. You will only see the upper 
left part of it. 

 
5. Press the Q key to pause the Content Player. 

 
6. Click the Shut Down button to shut down the Content Player. 

 

 
 

 NOTE: Once you initially launch and close the Content Player, it may 
continuously re-launch itself after you close it. This is a feature built into the player 
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in case of a computer crash, etc. Use the Content Player Configuration application 
(located in the same folder as the Content Manager and Content Player) to stop this 
from happening. Click the Stop/Start toggle button under the Deployment tab. 

 

 
 
EMERGENCY NOTIFICATIONS 
 
The Four Winds Digital Signage software includes methods for administrators to 
automatically send out emergency notifications to signs. Please discuss this with your 
local IT staff to ensure your signs are able to accept these notifications. You MUST 
enable an emergency channel on every sign to comply with Penn State policy. 

 
EXAMPLE 
In this exercise, you will define a new Penn State Emergency Channel. Defining a new 
channel is similar to setting up a playlist. 
 

1. Create the channel by right-clicking the Business Building location in the 
network tree and selecting the New Channel... option.  

 

NOTE: If you do not see a Properties dialog at this point, locate the new channel 
under the Business Building location in the network tree, right-click on it, and select 
Properties. 

 
2. Configure the channel as follows. 

 
Name: Emergency Channel 
Description: The Penn State Emergency Channel 
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Display and behavior: 
 Select Shrink templates and content if needed to fit the screen.  
 The checkbox for Align templates smaller than screen size should be 

checked.  
 Select Middle Center for the on screen location. 

Deployment properties: 
 Channel ID:  alerts_[YOURCAMPUSCODE]_V or H 

o Every campus has a unique campus code. For example, anyone at 
University Park (UP) would use alerts_UP_H or alerts_UP_V as a 
campus code (see Campus Codes below) 

o V = Vertical, H= Horizontal. Base your choice on the physical 
orientation of your sign. 

 Polling Interval: 01:00:00. 
 

 
 
Click the Connection properties link to view this sub-dialog screen. 

 Protocol: FTP 
 Host name: sign-ftp.its.psu.edu 
 User Name: Anonymous 
 Password: Any character(s) you want. This cannot be blank. You do not 

need to remember it. Do NOT user your PSU Access password! 
 Path: /pub/digitalsignage/[YOURCAMPUSCODE]/V or H 

o  See Campus Codes below. 
o V = Vertical, H= Horizontal. Base your choice on the physical 

orientation of your sign. 
  



 

Digital Signage at Penn State: The Basics  33 
   

 Port: 21 
 

 
 

3. Click anywhere outside of the Connection Properties dialog to close it. 
 

4. Click the OK button. 
 

5. Drag the Channel alerts icon and drop it onto the Second Floor sign in the 
network tree to subscribe to the emergency channel. 

 

 
 
Your sign should contain the subscribed channel as illustrated. 
 

 

NOTE: Each player must be subscribed individually to the emergency channel. 
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Campus Codes 
 
Code Campus Code Campus 
OZ Abington HN Hazleton 
AA Altoona HY Hershey 
BR Beaver AN Lehigh Valley 
BK Berks MA Mont Alto 
DE Brandywine NK New Kensington 
DN Dickinson-Carlisle SL Schuylkill 
DS DuBois SV Shenango 
BD Erie UP University Park 
FE Fayette WB Wilkes-Barre 
KP Great Valley WS Worthington Scranton 
MK Greater Allegheny YK York 
CL Harrisburg   
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Appendix A: Additional Support 
 
Four Winds Interactive Support 
 

 The Four Winds Wiki - http://wiki.fourwindsinteractive.com 
You must request a password to access this wiki. You may want your technical 
support staff to have access as well. 

 Ben Lawrence – Penn State Client Service Advocate 
Telephone: 303-995-1987 mobile | 720-294-1088 fax 

 Email: blawrence@fourwindsinteractive.com 
 General Telephone support: 877-204-6679, 8AM to 7 PM M-F EST.  

Call 720-259-5000 all other times. 
 Web support: http://www.fourwindsinteractive.com/contact-support.htm 
 Email support: support@fourwindsinteractive.com 

 

Penn State Support 
 

 The Penn State Digital Signage Overview: 
http://its.psu.edu/digitalsignage/overview . 

 The Penn State Digital Signage Web Site: 
https://wikispaces.psu.edu/display/Signage/Digital+Signage+at+Penn+State 

 The Penn State Digital Signage List: This electronic mailing list is used to share 
information of interest to all at Penn State using the Four Winds Digital Signage 
software. Join this list at http://lists.psu.edu/cgi-bin/wa?A0=L-
DIGITALSIGNAGE . 

  

http://wiki.fourwindsinteractive.com/
http://www.fourwindsinteractive.com/contact-support.htm
mailto:support@fourwindsinteractive.com
http://its.psu.edu/digitalsignage/overview
https://wikispaces.psu.edu/display/Signage/Digital+Signage+at+Penn+State
http://lists.psu.edu/cgi-bin/wa?A0=L-DIGITALSIGNAGE
http://lists.psu.edu/cgi-bin/wa?A0=L-DIGITALSIGNAGE
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Appendix B: Hardware and Software 
Requirements 

 
Hardware Requirements 
 
To create digital signage with the Four Winds Interactive Digital Signage software, you 
need a Windows-based machine running Windows 7 software. Ideally, this machine has 
access to local networks and the Internet. 
 
To deploy (run and display) a sign, you need a Windows-based machine running 
Windows 7 software. Ideally, you would have a large display attached to this machine. 
If your sign uses any media that requires applications to run it (such as Microsoft® 
Word), you will need that software installed as well. 
 
Software Requirements 
 
The Penn State Computer Store has a site license for the Four Winds Interactive Digital 
Signage software. See http://www.fourwindsinteractive.com/ for more information on 
Four Winds Interactive. See http://computerstore.psu.edu/ for current Penn State pricing 
and licensing options. 
 
The Four Winds Digital Signage software consists of a Content Manager for creating and 
managing sign content, and a Content Player for showing sign content. The Content 
Manager typically is installed on the computer used to create and manage content. The 
Content Player must be installed on the machine used to show the sign. It may also be 
installed on the same machine as the Content Manager for testing purposes. 
  

http://www.fourwindsinteractive.com/
http://computerstore.psu.edu/
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Appendix C: Installing the Four Winds 
Content Manager and Content Player 

 
The Four Winds Digital Signage software consists of a Content Manager for creating and 
managing sign content, and a Content Player for showing sign content. The Content 
Manager typically is installed on the computer used to create and manage content. The 
Content Player must be installed on the machine used to show the sign. It may also be 
installed on the same machine as the Content Manager for testing purposes. 
 
The Penn State Computer Store has a site license for the Four Winds Interactive Digital 
Signage software. See http://www.fourwindsinteractive.com/ for more information on 
Four Winds Interactive. See http://computerstore.psu.edu/ for current Penn State pricing 
and licensing options. 
 
Software License Keys 
 
You will receive your license keys after you purchase the software, as well as directions 
for activating the keys. The easiest way to add the keys is to go to the Help menu for 
both the Content Manager and Content Player and select the About choice. 
 
How to Download the Software at PSU 
 

1. Open the Firefox browser. 
 

NOTE: If you are working remotely, you must also use the VPN software to ensure 
a secure connection. Please see http://aset.its.psu.edu/vpn/ for more information 
and installation instructions. 

 
2. Type https://explorer.pass.psu.edu/ in the browser address bar.  

 

NOTE: You may need to authenticate with your Penn State user ID and Password 
to enter PASS Explorer. 

  

http://www.fourwindsinteractive.com/
http://computerstore.psu.edu/
http://aset.its.psu.edu/vpn/
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3. Choose <Enter a path> from the Browse To: drop-down menu. 
 

 
 

4. Type /pass/services/digitalsignage in the folder location dialog. 
 

 
 

5. Click the OK button. 
 

6. Select the [software] choice. 
 

 
 

7. Click the Change Folder button. 
 

8. Click on the most current version of the software. 
  



 

Digital Signage at Penn State: The Basics  39 
   

9. Click on the Current folder. 
 

 
 

10. Click the Change Folder button. 
 

11. Click on the most current version of the software. 
 

12. Click the Download button. 
 

13. Click the Click to Start Download button. 
 

14. Close the download dialog when the download completes. 
 

15. Navigate to the Downloads folder. 
 

16. Double-click the ContentManager.zip file to open it and start a standard 
Windows installation procedure. Follow the prompts to install the software. 
 

17. Repeat steps 11-16 for the Content Player. 
 

18. Activate the software by adding the license keys you received when you 
purchased the software. 
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Appendix D: Create a Local Database With 
Shared Access 

 
Follow these steps if you want to store your local database on a network drive (to share 
access with others). 
 

1. Launch (open) the Content Manager.  
 

 
 

2. Click the Create a new local database radio button. 
 

3.  Click the Next button. 
 

4. Add your company/department information as desired. It is recommended you 
use Penn State [Your College and Dept. Name] (e.g., Penn State College of Ag 
Entomology Dept.). 
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5. Click the  button to the right of the Content Path field to store your local 
database on a network drive (to share access with others). 
 

6. Double-click  your  network  drive.  In  this  example,  an  individual’s  PASS  space  is  
being used. 
 

 
 

7. Double-click your network folder. In this example, MyDigitalSignageFolder is 
used. 
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8. Once you have a network folder on a network drive identified, your Content 
Path field on the Set up your company dialog should contain the path to the 
network folder. 
 

 

Note: You must ensure all users can access a shared network folder. If you use 
PASS space, you must establish a User Managed Group (UMG). Please see 
http://kb.its.psu.edu/article/1010 for more information. 

 



 

 

Technology Training Resources 

Through ITS Training Services 
Find face-to-face and online training workshops through Penn State ITS Training Services at 
http://its.psu.edu/training/catalog/  

Learn about Training On Demand (sessions upon request for groups of five or more) at 
http://its.psu.edu/training/ondemand/  

Explore thousands of free video tutorials that are available for self-paced learning at 
http://lynda.psu.edu/  

Take free Microsoft eLearning courses or find out more about free certification vouchers at 
http://msitacademy.psu.edu/  

Discover training news, fun tips, and session reminders via social media on 
@psuITStraining (Twitter) 
http://www.facebook.com/psuitstraining/ (Facebook) 

Join one of our news lists to receive monthly email notification of all upcoming technology training 
opportunities, by sending a blank email to 
L-TRAINING-NEWS-SUBSCRIBE-REQUEST@LISTS.PSU.EDU (Training News List) 
L-FACULTY-TECHTRAINING-SUBSCRIBE-REQUEST@LISTS.PSU.EDU (Faculty Training List) 
L-CAMPUS-TECHTRAINING-SUBSCRIBE-REQUEST@LISTS.PSU.EDU (Campus Training List) 

Additional Technology Resources 
Contact the IT Service Desk with general technology-related questions by emailing 
ITServiceDesk@psu.edu or call 814-865-4357 (HELP) 

Search for technology-related information in the IT Knowledge Base at 
http://kb.its.psu.edu/  

Purchase discounted software or software licenses through Penn State at 
http://software.psu.edu/  

Access free online books about popular technology topics through the Penn State Libraries at 
http://proquest.safaribooksonline.com/ 

 

ITS  Training  Services  at  Penn  State 
23 Willard Building  University Park, PA  16802 
Phone: 814-863-9522  Fax: 814-865-3556  itstraining@psu.edu 
http://its.psu.edu/training/  

http://its.psu.edu/training/catalog/
http://its.psu.edu/training/ondemand/
http://lynda.psu.edu/
http://msitacademy.psu.edu/
http://twitter.com/psuITStraining
http://www.facebook.com/psuitstraining/
mailto:ITServiceDesk@psu.edu
http://kb.its.psu.edu/
http://software.psu.edu/
http://proquest.safaribooksonline.com/
mailto:itstraining@psu.edu
http://its.psu.edu/training/

